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Copyright

Dieses Dokument unterliegt dem Copyright © 2010–2023. Die Beitragenden sind unten aufgeführt. 
Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public License 
(http://www.gnu.org/licenses/gpl.html), Version 3 oder höher, oder der Creative Commons 
Attribution License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 oder höher, 
verändern und/oder weitergeben.

Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt.

Fast alle Hardware- und Softwarebezeichnungen sowie weitere Stichworte und sonstige Angaben, 
die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.

Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, wird das 
Symbol (R) in diesem Buch nicht verwendet.

Mitwirkende/Autoren

| Michael Otto | Susanne Mohn |

Englisches Originaldokument

Dieses Kapitel wurde ursprünglich aus dem Englischen übersetzt und basiert auf dem Chapter 6 
des Guides "Editing Images". Autor dieses Kapitels ist:

| Peter Schofield |

Rückmeldung

Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert und kann 
nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!

Datum der Veröffentlichung und Softwareversion

Veröffentlicht am 14.12.2023. Basierend auf der LibreOffice Version 7.6.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.
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Verwendung von LibreOffice unter macOS

Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-Version 
und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen einige 
grundlegende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der Hilfe der 
jeweiligen Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen

LibreOffice > Einstellungen Zugriff auf die Programmoptionen

RECHTSKLICK

CTRL+KLICK und/oder 
RECHTSKLICK je nach 
Einstellungen

Öffnen eines Kontextmenüs

STRG (Steuerung) ⌘ (Command)
Tastenkürzel in Verbindung mit anderen 
Tasten

ALT ⌥ und/oder Alt oder Option
Tastenkürzel in Verbindung mit anderen 
Tasten

F11 ⌘+T
Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme

Hier verwendete Synonyme:

für werden in diesem Dokument verwendet

Abschnitt Bereich

Deck, Seitenleiste

Dialogfeld, Dialogbox, Dialog

Menüleiste, Hauptmenü, Menü

Register, Reiter, Tabulator, Tab

Sie sehen vielleicht etwas anderes

LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von denen 
jedes Betriebssystem unterschiedliche Versionen hat, und kann von den Nutzern bezüglich 
Schriftarten, Farben und Themen angepasst werden.

Die Bilder in diesem Handbuch wurden mit hellem Thema in Ubuntu 20.04 erstellt. Das LibreOffice 
Thema entspricht der Werkseinstellung.
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Einleitung

Dieses Kapitel des Draw Handbuchs beschreibt das Bearbeiten von Rastergrafiken. Draw enthält 
eine Vielzahl an Funktionen, um Rastergrafiken oder Bitmaps wie Fotos und gescannte Bilder zu 
bearbeiten, sowie diese zu importieren, zu exportieren oder von einem Format in ein anderes zu 
konvertieren. 

Draw kann die Mehrzahl der Grafikdateiformate lesen und benutzt Eigenschaften ähnlich wie 
Rastergrafikprogramme wie Gimp und Adobe Photoshop. Rastergrafiken sind Bilder oder Fotos 
zumeist in diesen gängigen Formaten:
JPG/JPEG (Joint Photographic Experts Group)

JPEG ist das am weitesten verbreitete Bildformat auf Internetseiten, die meisten Digitalkameras und 
Smartphones erzeugen standardmäßig JPEG-Fotos, es verwendet eine verlustbehaftete Kompression.
GIF (Graphics Interchange Format)

GIF ist ein Bitmap-Dateiformat das aufgrund seiner weiten Unterstützung und Portabilität verbreitet ist, es 
verwendet eine Farbpalette, die auf 256 Farben und Transparenz beschränkt ist, erlaubt eine verlustfreie 
Komprimierung und Animationen.
PNG (Portable Network Graphics)

PNG ist ein Rastergrafikformat, das verlustfreie Datenkompression und Transparenz unterstützt, Dateien 
sind in der Regel wesentlich größer als bei JPEG.
TIF/TIFF (Tagged Image File Format)

TIFF ist ein komplexes Format, dabei flexibel und anpassungsfähig, komprimiert verlustfrei, unterstützt das 
CMYK-Farbmodell und kann eine hohe Farbtiefe bis zu 32 bit je Komponente verwenden.
BMP (Windows Bitmap)

BMP ist auch bekannt als Bitmap-Bilddatei mit einer Punktmatrix-Datenstruktur, sind relativ einfach 
aufgebaut, unkomprimiert oder verlustfrei komprimiert und dadurch wesentlich größer.

Die anderen Kapitel dieses Draw Handbuchs beschreiben ausschließlich Vektorgrafiken. Die 
gängigen Typen für Vektorgrafik sind:
SVG (Scalable Vector Graphics)

SVG ist ein auf Extensible Markup Language (XML) basierendes Vektorgrafikformat für zweidimensionale 
Grafik, das Interaktivität und Animation unterstützt.
EPS (Encapsulated PostScript)

EPS ist ein PostScript-Dokumentformat, das als verlustfreies Grafikdatei-Format genutzt wird, indem in der 
Seitenbeschreibungssprache PostScript eine einzelne Seite beschrieben wird. EPS-Dateien sind in sich 
abgeschlossen. PostScript-Dokumente, die ein Bild oder eine Grafik beschreiben, können in einem weiteren 
PostScript-Dokument enthalten sein. EPS wurde durch PDF weitgehend abgelöst.
AI (Adobe Illustrator)

AI ist ein proprietäres Dateiformat des Programms Adobe Illustrator, das von Adobe Systems entwickelt 
wurde. Es setzt auf PostScript auf, einseitige vektorbasierte Zeichnungen werden im EPS- oder PDF-
Format dargestellt.

Hinweis

Details zu Grafikformaten finden sich unter https://de.wikipedia.org/wiki/Grafikformat
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Bildobjekte

Einbetten oder Verknüpfen

Durch das Einbetten eines Bildes in eine Zeichnung wird das Bild Teil der Zeichnung. Alle 
Änderungen, die an einem eingebetteten Bild vorgenommen werden, erscheinen ausschließlich in 
der Zeichnung, in die das Bild eingebettet wurde. Das ursprüngliche Bild wird nicht verändert.

Der entscheidende Vorteil eines eingebetteten Bildes ist, dass das Bild stets verfügbar ist, auch 
wenn die Zeichnung auf einem anderen Rechner geöffnet wird.

Als Nachteil kann gesehen werden, dass es zu größeren Dateien führt. Zudem wird das Bild in der 
Zeichnung nicht aktualisiert, wenn das ursprüngliche Bild verändert wird.

Beim Verknüpfen wird das Bild nicht in die Zeichnung eingefügt sondern eine Verknüpfung 
erzeugt, die auf die Bilddatei zeigt. Bei jedem Öffnen der Zeichnung werden alle verknüpften Bilder 
aus der jeweiligen Bilddatei geladen.

Der wesentliche Vorteil einer Verknüpfung des Bildes in die Zeichnung ist, dass jede Änderung 
oder Ersetzung der Bilddatei auch in der Zeichnung wirksam wird. Wenn die Zeichnung geöffnet 
wird, wird stets das aktuelle Bild in der Zeichnung dargestellt.

Dabei ist die Datei der Zeichnung entsprechend kleiner. Das in die Zeichnung verknüpfte Bild kann 
zudem mit für die Grafikbearbeitung spezialisierten Programmen bearbeitet werden.

Der Nachteil des Verknüpfens ist, dass die Verknüpfung in der Zeichnung an Änderungen des 
Namens und des Ablageortes der Bilddatei stets angepasst werden muss. Wird die Bilddatei 
umbenannt oder verschoben, dann muss diese Änderung in der Zeichnung nachgetragen werden.

Wird die Zeichnung auf einen anderen Rechner übertragen, dann muss auch die Bilddatei an den 
anderen Rechner übertragen werden und dort am entsprechenden Ort im Dateisystem abgelegt 
werden.

Bild Einfügen

Eine Bilddatei in eine Zeichnung als eingebettetes Bild zu importieren, geschieht durch

• Einfügen > Bild oder in der Symbolleiste durch  

━ es erscheint der Dialog Bild einfügen (Abbildung 1),

━ den Dateipfad und den Dateinamen des gewünschten Bildes auswählen,

━ die Option Verknüpfen nicht selektieren und Öffnen klicken,

• Kopieren und Einfügen (siehe Abschnitt Kopieren, Ausschneiden und Einfügen),

• Scannen eines Bildes (siehe Anschnitt Scannen) oder

• Klicken und Ziehen zwischen geöffneten Dateien.

Wenn Vorschau selektiert ist, dann wird das gewählte Bild am rechten Rand des Dialogfensters 
gezeigt. Dies vereinfacht die Auswahl des gewünschten Bildes und zeigt zugleich, ob das 
Dateiformat verwendet werden kann.

Draw enthält Importfilter für die meisten Grafikformate. Wenn ein Bild in einem Grafikformat 
importiert werden soll, das von den Importfiltern nicht unterstützt wird, kann ein Konvertierungs-
programm verwendet werden, um die Datei in ein Format umzuwandeln, das von Draw erkannt 
wird.
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Abbildung 1: Dialog Bild einfügen

Verknüpfung einfügen

Ein Bild als Verknüpfung in eine Zeichnung einzufügen geschieht durch

• Einfügen > Bild oder in der Symbolleiste durch  

━ es erscheint der Dialog Bild einfügen (Abbildung 1),

━ den Dateipfad und den Dateinamen des gewünschten Bildes auswählen,

• die Option Verknüpfen selektieren und Öffnen klicken,

• im darauffolgenden Dialog Verknüpfte Bilder bestätigen (Abbildung 2) auf Verknüpfung 
beibehalten klicken. Wird stattdessen Bild einbetten gewählt, dann wird das Bild nicht 
verknüpft sondern eingebettet (siehe Abschnitt Bild Einfügen).

Abbildung 2: Dialog Verknüpfte Bilder bestätigen

Hinweis

Wenn ein Bild in eine Zeichnung verknüpft wird, wird das Format des verknüpften 
Bildes nicht verändert.
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Verknüpfung bearbeiten

Verknüpfungen können aktualisiert, geändert oder gelöst werden:

• das Bild auswählen und mit Bearbeiten > Externe Verknüpfungen den Dialog 
Verknüpfungen bearbeiten öffnen (Abbildung 3), 

• klicken auf Ändern, Lösen oder Aktualisieren,

━ Ändern – ändert die Datei der Verknüpfung und damit das Bild in der Zeichnung. Im 
nachfolgenden Dialog (siehe Abschnitt Verknüpfung einfügen) kann eine andere Datei 
gewählt werden, hier muss erneut die Option Verknüpfen gewählt werden.

━ Lösen – entfernt die Verknüpfung zwischen der Bilddatei und der Zeichnung. Das Bild aus 
der Datei wird in die Zeichnung eingebettet (siehe Abschnitt Einbetten oder Verknüpfen). In 
einem Dialog muss bestätigt werden, dass die Verknüpfung wirklich gelöst werden soll.

━ Aktualisieren – ändert die Darstellung des Bildes in der Zeichnung auf den aktuellen Stand 
der Datei. Dies ist sinnvoll, wenn die Bilddatei seit dem Öffnen der Zeichnung verändert 
wurde.

• klicken auf Schließen, um das Dialogfenster zu schließen.

Abbildung 3: Dialog Verknüpfungen bearbeiten

Hinweis

Falls in der Zeichnung kein Bild als Verknüpfung eingefügt wurde sondern alle Bilder 
eingebettet wurden, ist Bearbeiten > Externe Verknüpfungen ausgegraut.

Scannen

Durch Scannen wird ein Bild im Format PNG in die Zeichnung eingebettet. Um ein Bild zu 
scannen, muss ein Scanner im Rechner konfiguriert und unterstützt werden von

• TWAIN für die Betriebssysteme Windows und Mac,

• SANE für Linux-Betriebssysteme.

Das Vorgehen beim Scannen unterscheidet sich je nach Treiber, Schnittstelle und Betriebssystem, 
gegebenenfalls sollte die Dokumentation des Scanners beachtet werden. Zum Scannen

• das gewünschte Dokument in den Scanner einlegen, der Scanner muss eingeschalten und 
betriebsbereit sein,
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• beim erstmaligen Benutzen des Scanners Einfügen > Medien > Scannen > Quelle 
auswählen und Verwendetes Gerät, auswählen, falls der Scanner bereits eingerichtet wurde, 
Einfügen > Medien > Scannen > Anfordern auswählen,

• die Auflösung und den Scanbereich auswählen und Scannen klicken.

Das gescannte Bild wird dadurch in die Zeichnung eingebettet und kann wie andere Bilder 
bearbeitet werden.

Hinweis

Falls mehrere Scanner am Rechner angeschlossen sind, wird das durch Quelle 
auswählen bestimmte Gerät zur Standardeinstellung für Anfordern, bis ein anderes 
Gerät durch Quelle Auswählen bestimmt wird.

Kopieren, Ausschneiden und Einfügen

Mit Kopieren und Einfügen werden Bilder in eine Zeichnung eingebettet. Ein kopiertes Bild kann 
ein Bild sein, das bereits in dem gleichen oder einem anderen Dokument enthalten ist, oder es 
kann die Datei einer Zeichnung, eines Dokuments oder eines Fotos sein. 

Mit Kopieren (Tastenkombination Strg+C ) wird das Bild in die Zwischenablage kopiert, mit 

Ausschneiden (Tastenkombination Strg+X ) wird das Bild in die Zwischenablage kopiert und das 
kopierte Bild gelöscht. Dies kann auch mithilfe eines anderen Programms aus einem anderen 
Dokument geschehen. 

Um den Inhalt der Zwischenablage in die Zeichnung einzufügen 

• mit Bearbeiten > Inhalte einfügen > Inhalte einfügen (Tastenkombination Strg+V ) den 
Dialog Inhalte Einfügen aufrufen, 

• das gewünschte Datenformat zum Einfügen in die Zeichnung auswählen, die angebotenen 
Formate sind abhängig vom Format des in die Zwischenablage kopierten Bildes, 

• OK klicken. 

Hinweis

Beim Kopieren und Einfügen von Bildern müssen ggf. die Urheberrechte und Lizenz-
bedingungen der Quelle beachtet werden. 

Name und Beschreibung

Bilder können ebenso wie andere Objekte in der Zeichnung mit einem Namen versehen werden. 
Damit sind sie mithilfe des LibreOffice Navigator leichter auffindbar. 

• Format > Name wählen oder im Kontextmenü des Bildes Name wählen, 

• im Dialog Name einen Namen eingeben und OK klicken. 

Über den Namen hinaus kann einem Bild ein Alternativtext und eine Beschreibung gegeben 
werden (siehe Abbildung 4). 

• Format > Beschreibung wählen oder im Kontextmenü des Bildes Beschreibung wählen, 

• im Dialog Beschreibung einen Alternativtext und eine Beschreibung eingeben und OK klicken. 
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Abbildung 4: Dialog Beschreibung

Hinweis

Alternativtext und Beschreibung werden beim Exportieren des Bildes mit einem 
entsprechenden Tag im HTML- und PDF-Format versehen, wenn dabei die Option 
Universelle Zugänglichkeit (PDF/UA) aktiviert wird.

Bilder und Objekte exportieren

Einzelne Objekte oder Gruppen von Objekten einer Zeichnung können selektiv exportiert werden. 
Hierzu in Draw die gewünschten Objekte auswählen (Objekte zur Auswahl hinzufügen z. B. durch 
Umschalt+Klick) und mit Datei > Exportieren im Dialog Datei Exportieren (Abbildung 5) 

• Ordner und Name für die zu erzeugende Datei wählen, 

• die Option Auswahl anwählen,

• in der Auswahlliste unten rechts das gewünschte Dateiformat wählen und

• Exportieren klicken.

• Für einige Dateiformate öffnet sich ein weiterer Dialog, in dem Parameter der erzeugten Datei 
gewählt werden können.

Abbildung 5: Dialog Datei exportieren
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Hinweis

Beim Exportieren werden bearbeitete Bilder so abgelegt, wie sie in der Zeichnung 
dargestellt werden. Vergleiche hierzu stattdessen Speichern im Abschnitt Bilder 
bearbeiten.

Zeichnung exportieren

Die mit Draw erstellten Zeichnungen werden im Open Document Format (ODG) gespeichert. 
Einige andere Grafikprogramme können dieses Format nicht interpretieren. Um eine Zeichnung für 
solche Programme verfügbar zu machen, kann eine Zeichnung in verschiedene andere Formate 
exportiert werden. Exportieren kann je nach verwendetem Betriebssystem unterschiedlich 
aussehen, dazu die betreffende Zeichnung mit Draw öffnen und mit Datei > Exportieren im Dialog 
(Abbildung 5) 

• Ordner und Name für die zu erzeugende Datei wählen, 

• die Option Auswahl (siehe Abschnitt Bilder und Objekte exportieren) wird dabei nicht 
angewählt,

• in der Auswahlliste unten rechts das gewünschte Dateiformat wählen, 

• Exportieren klicken.

Für einige Dateiformate öffnet sich auch hier ein weiterer Dialog, in dem Parameter der erzeugten 
Datei gewählt werden können.
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Bilder bearbeiten

Bilder in Form von Rastergrafiken können bearbeitet und formatiert werden, indem Filter darauf 
angewendet werden oder Eigenschaften von Farbe, Linien, Bereiche und Schatten geändert 
werden. Die Bearbeitung wird gewählt mit Format > Bild > ... oder im Kontextmenü mit 
Rechtsklick auf ein ausgewähltes Bild oder in der Symbolleiste Bild (siehe Abbildung 6).

Abbildung 6: Symbolleiste Bild

Hinweis

Die Funktionen 
    • Position und Größe • Drehen oder spiegeln 
    • Linie • Umwandeln 
    • Objekte ausrichten • Formatvorlage bearbeiten 
    • Anordnung 
gelten für alle Objekte einer Zeichnung, Beschreibungen hierfür siehe Draw Handbuch 
Kapitel 3 - Arbeiten mit Objekten und Objektpunkten, Kapitel 4 - Objekteigenschaften 
ändern und Kapitel 5 - Arbeiten mit mehreren Objekten.

Menü und Symbolleiste Bild

• Zuschneiden  (interaktiv durch Ziehen mit der Maus) – Durch Auswahl dieser Funktion 
ändern sich die Ziehpunkte des Bildes in größere Rechtecke, dann kann ein Ausschnitt des 
Bildes durch Klicken und Ziehen der Ziehpunkte gewählt werden: 

━ Mit dem oberen, unteren, linken und rechten Ziehpunkt wird nur die jeweilige Seite 
beschnitten. 

━ Mit den Ziehpunkten an den Ecken werden zwei Seiten in einem Zug beschnitten, dabei 
kann das Seitenverhältnis des Bildes erhalten werden, indem die Umschalt -Taste beim 
Ziehen gehalten wird.

━ Wird ein Ziehpunkt dabei über die gegenüberliegende Seite hinaus gezogen, dann wird das 
Bild damit zugleich gekippt (horizontal, vertikal oder horizontal und vertikal gespiegelt).

Im Dialog Zuschneiden (siehe Abschnitt Dialog Zuschneiden, Skalierung und Bildgröße hier 
unten) können stattdessen die Größen exakt numerisch eingegeben werden.

• Originalgröße – Ändern der Größe des Bildes in der Zeichnung auf die Größe des 
ursprünglich eingefügten Bildes.

• Mit externem Werkzeug bearbeiten – Bearbeiten des Bildes mit dem für dieses Grafikformat 
als Standard im Betriebssystem eingestellten Programm.

• Ersetzen – Durch Dateiauswahl ein anderes Bild anstelle des ausgewählten Bildes einfügen, 
siehe Abschnitt Bild Einfügen und Abbildung 1.
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• Komprimieren – Die Auflösung oder Größe eines Bildes verändern, siehe hierzu unten den 
Abschnitt Dialog Bild komprimieren.

• Speichern – Speichern des in der Zeichnung eingebetteten Originalbildes als Datei. Sofern 
das Bild in der Zeichnung verändert wurde, kann in einem Dialog gewählt werden, ob das 
Originalbild oder die geänderte Version gespeichert werden soll. (Vergleiche hierzu statt-
dessen Exportieren im Abschnitt Bilder und Objekte exportieren).

• Filter > …  – Bearbeitung durch Grafikfilter, siehe hierzu die 
Beschreibung unten im Abschnitt Grafikfilter.

• Farbe  – Im Dialog Farbe (Abbildung 7) können Rot-, Grün- 
und Blauanteil sowie Helligkeit, Kontrast und Gamma verändert 
werden. Das in der Zeichnung enthaltene Originalbild wird 
dadurch nicht verändert sondern nur die Darstellung des Bildes. 
Einige Farbeinstellungen, Helligkeit, Kontrast und Transparenz 
sind auch in der Seitenleiste unter Eigenschaften im Abschnitt 
Grafik wählbar, wenn ein Bild ausgewählt wurde.

• Zuschneiden… mit Dialog –  Auswählen eines Ausschnitts des Bildes mit numerischer 
Eingabe der Größen im Dialog Zuschneiden, siehe hierzu die Beschreibung unten im 
Abschnitt Dialog Zuschneiden, Skalierung und Bildgröße.

• Grafikgröße prüfen – Falls in Datei > Eigenschaften > Bevorzugte Auflösung für Bilder 
ein Wert angegeben wurde, werden im Dialog Graphic Size Check alle Bilder der Zeichnung 
auf Übereinstimmung hierauf geprüft. Mit Eigenschaften kann der Dialog Zuschneiden jedes 
Bildes aufgerufen werden, mit Markierung kann eines der Bilder ausgewählt werden. 

• Drehung und Neigung – Ist ein Bild ausgewählt (die Ziehpunkte werden dargestellt), ändern 
sich durch einen zweiten Klick auf das Bild (oder im Kontextmenü mit Drehen oder Spiegeln 
> Drehen) die Ziehpunkte des Bildes in Kreise. 

━ Mit den Ziehpunkten an den Ecken kann dann das Bild gedreht werden. Wird beim Ziehen 
die Umschalt -Taste gehalten, dann wird in exakten Schritten von 15° gedreht. Durch 
Verschieben des Ziehpunktes in der Mitte kann der Drehpunkt zuvor gewählt werden.

━ Mit den Ziehpunkten an den vier Seiten kann das Bild geschert (schräg gestellt) werden, 
indem die Umschalt -Taste beim Ziehen gehalten wird, wird in exakten Schritten von 15° 
geschert. Die Schrittweite kann über Extras > Optionen > LibreOffice Draw >Raster > 
Beim Drehen angepasst werden.

Mit Format > Position und Größe kann im Dialog Position und Größe ein Bild gedreht und 
geneigt und dabei der Drehwinkel und der Drehpunkt bzw. die Neigung exakt numerisch an-
gegeben werden, siehe Draw Handbuch Kapitel 3 - Arbeiten mit Objekten und Objektpunkten.

Hinweis

Bearbeitete Bilder können mit Datei > Exportieren (mit Option Auswahl) als Datei 
abgelegt werden, siehe hierzu den Abschnitt Bilder und Objekte exportieren. Im 
Gegensatz dazu wird mit Speichern (siehe hier oben) das Originalbild abgelegt.

Dialog Zuschneiden, Skalierung und Bildgröße

Mit Format > Bild > Zuschneiden... wird der Dialog Zuschneiden (Abbildung 8) geöffnet. Ein 
Ausschnitt des Bildes, die Skalierung und die Bildgröße können hier mit exakter numerischer 
Angabe gewählt werden. (Vgl. hier oben interaktives Zuschneiden durch Ziehen mit der Maus.)
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Unter Zuschneiden wird 

• mit Skalierung beibehalten gewählt, dass der Maßstab des Bildes erhalten bleiben und die 
Bildgröße sich verändern soll oder 

• mit Bildgröße beibehalten gewählt, dass die Bildgröße erhalten bleiben und der Maßstab sich 
verändern soll.

• Für Links, Rechts, Oben und Unten wird die Größe des Zuschnitt gewählt, dieser Wert bezieht 
sich auf die Originalgröße (Breite bzw. Höhe) des Bildes. Mit  -  und  +  kann der Wert in 
Schritten von 1/20 der Originalgröße geändert werden.

━ Mit positiven Werten wird das Bild verkleinert. 

━ Mit negativen Werten wird ein transparenter Rand hinzugefügt.

Abbildung 8: Dialog Zuschneiden

Unter Skalierung kann ohne Zuschneiden der Maßstab für die Höhe und für die Breite gewählt 
werden, dabei wird die Bildgröße entsprechend angepasst.

• Im Zahlenfeld kann der Maßstab in % gewählt werden,

• mit  -  und  +  kann der Wert in Schritten von 10% der Originalgröße geändert werden.

Unter Bildgröße kann ohne Zuschneiden die Höhe und die Breite des Bildes gewählt werden, 
dabei wird die Skalierung entsprechend angepasst.

• Im Zahlenfeld kann die Größe in cm gewählt werden,

• mit  -  und  +  kann die Größe in Schritten von 0,10 cm geändert werden.

Dialog Bild komprimieren

Um die Dateigröße der Zeichnung zu verringern, können Bilder darin komprimiert oder ihre 
Auflösung verringert werden.

Mit Format > Bild > Komprimieren oder im Kontextmenü mit Rechtsklick auf ein ausgewähltes 
Bild und Komprimieren wird der Dialog Bild komprimieren (siehe Abbildung 9) aufgerufen.

Komprimieren ist möglich 

• mit JPEG-Qualität, diese Komprimierung erreicht eine sehr gute Verringerung der Größe, ist 
jedoch verlustbehaftet, der Standard-Wert ist 90, kleinere Werte verschlechtern das Bild, 
größere Werte haben eine geringere Einsparung, 
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• mit PNG-Komprimierung, diese ist verlustfrei, erreicht jedoch weniger Einsparung als JPEG, 
ein hoher Wert bedeutet mehr Einsparung und mehr Berechnungsaufwand. 

Abbildung 9: Dialog Bild komprimieren

Unter Auflösung kann das Bildauflösung verringern eingeschaltet werden, dann können 

• die Breite oder die Höhe gewählt werden (Mit  -  und  +  kann der Wert in Schritten von 100 
px geändert werden), dabei wird unter Beibehalten des Seitenverhältnisses die Höhe bzw. 
Breite sowie die sich daraus ergebende Auflösung angepasst, oder 

• die Auflösung gewählt werden, dann werden die Breite und die Höhe angepasst. 

• Werden Breite und Höhe oder die Auflösung vergrößert, dann ergibt sich eine negative 
Reduzierung, d. h. das Bild ist größer als zuvor. 

Die Bildinformation beschreibt das Bild vor dem Komprimieren, mit Neue Größe berechnen kann 
die Einsparung der Bildgröße angezeigt werden. 

Vorsicht

Durch Komprimieren wird das in der Zeichnung eingebettete Originalbild verändert. 
Wird die Auflösung verringert, ist es damit unschärfer. Wird die Auflösung danach 
wieder erhöht, dann ist das Bild wieder größer, bleibt jedoch unscharf.
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Grafikfilter

Auf die Bilder in einer Zeichnung können Grafikfilter 
angewendet werden. Das zu bearbeitende Bild wird 
ausgewählt und der Filter mit Format > Bild > Filter > … 
oder in der Symbolleiste Bild im Untermenü Filter  oder 
in der Symbolleiste Filter aufgerufen. Bei einigen Filtern 
erscheint ein Dialog, in dem Parameter des Filters gewählt 
werden können. Es können auch mehrere Filteroperationen 
hintereinander kombiniert werden. An einem Bild, das in 
Abbildung 10 unverändert dargestellt ist, werden die Wirkungen der verfügbaren Filter gezeigt. 

Hinweis

Mit dem Speichern der Zeichnung werden die geänderten Bilder gespeichert. Die 
Filteroperationen können mit Rückgängig wieder zurückgenommen werden, solange 
die Zeichnung nicht geschlossen wird, auch wenn die Zeichnung bereits gespeichert 
wurde. Nach dem Schließen und nächsten Öffnen der Zeichnung kann die Änderung 
nicht mehr zurückgenommen werden. 

Vorsicht

Werden Filter auf verlinkte Bilder angewendet, dann werden diese Bilder beim 
Speichern in die Zeichnung eingebettet und mit abgelegt, sodass die Zeichnungsdatei 
entsprechend größer wird. 

Altern

Der Filter Altern (Symbolleiste ) lässt das Bild als 
vergilbt erscheinen, es wird in Graustufen umgewandelt 
und je nach einstellbarem Alterungsgrad die grün- und 
blau-Anteile reduziert, so dass sich eine braun- bzw. rot-
Färbung ergibt, siehe Abbildung 11 mit Alterungsgrad 10%.

Kohlezeichnung

Der Filter Kohlezeichnung (Symbolleiste ) lässt das 
Bild wie eine Kohlezeichnung erscheinen, die Konturen 
der Grafik werden schwarz gezeichnet und die Farben 
unterdrückt, siehe Abbildung 12.

Invertieren

Der Filter Invertieren (Symbolleiste ) kehrt alle Farben 
in ihre Komplementärfarben um, das Bild sieht damit also 
aus wie das entsprechende Fotonegativ, siehe 
Abbildung 13.
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Abbildung 11: Filter Altern

Abbildung 10: Bild ohne Filter

Abbildung 12: Filter Kohlezeichnung

Abbildung 13: Filter Invertieren



Mosaik

Der Filter Mosaik (Symbolleiste ) verbindet eine 
horizontal und vertikal getrennt einstellbare Zahl von Pixeln 
zu einem einzigen Pixel, vergröbert also die Auflösung, das 
Bild wirkt „verpixelt“. Zusätzlich kann Kanten hervorheben 
gewählt werden, was die Formen im Bild wieder etwas 
deutlicher erscheinen lässt. Siehe Abbildung 14 mit 
horizontal und vertikal 6 Pixel und Kanten hervorgehoben.

Pop-Art

Der Filter Pop-Art (Symbolleiste ) verbindet Flächen von 
ähnlicher Farbe zu zusammenhängenden größeren Flächen, in 
Abbildung 15 verdeutlicht an einem besser geeigneten Foto.

Poster

Der Filter Poster (Symbolleiste ) reduziert die Farben 
auf wenige Farben, von 2 bis 24 einstellbar. Ähnlich wie bei 
Pop-Art entstehen dadurch größere zusammenhängende 
Flächen von einheitlicher Farbe, siehe Abbildung 16 mit 16 
Farben.

Relief

Der Filter Relief (Symbolleiste ) erzeugt eine scheinbar 
zweidimensionale Fläche mit reliefartigen Erhebungen 
entsprechend den Farbkontrasten des Bildes. Die Richtung 
des Lichteinfalls kann aus verschiedenen Lichtquellen 
gewählt werden, siehe Abbildung 17 mit der Lichtquelle von 
rechts oben.

Rauschen entfernen

Der Filter Rauschen entfernen (Symbolleiste ) wendet einen Median-Filter auf das Bild an, um 
ungleichmäßige Farbverläufe, die z. B. durch das Rauschen in Bildsensoren besonders in dunklen 
Bildbereichen auftreten, auszugleichen.

Schärfen

Der Filter Schärfen (Symbolleiste ) ist ein Hochpass-
filter, mit dem der Kontrast an den Rändern von Konturen 
im Bild erhöht wird. Abbildung 18 stellt einen direkten 
Vergleich gegenüber: links ohne Filter, rechts nach dem 
Schärfen.

Grafikfilter 18

Abbildung 14: Filter Mosaik

Abbildung 15: Filter Pop-Art

Abbildung 16: Filter Poster

Abbildung 17: Filter Relief

Abbildung 18: Filter Schärfen



Weichzeichnen

Der Filter Weichzeichnen (Symbolleiste ) ist ein Tief-
passfilter, mit dem der Kontrast verringert wird, das Bild 
wirkt verwischt. Der Weichzeichnungsradius kann von 0,1 
bis 100,0 gewählt werden. Abbildung 19 zeigt das 
Weichzeichnen mit Radius 5,0.

Solarisation

Der Filter Solarisation (Symbolleiste ) soll den Effekt 
der Überbelichtung in der Analogfotografie nachempfinden, 
dabei können auch Bereiche mit Farbumkehr auftreten. 
Der Schwellwert kann von 0 bis 100% gewählt werden. 
Abbildung 20 zeigt das Weichzeichnen mit einem 
Schwellwert von 50%.
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Abbildung 19: Filter Weichzeichnen

Abbildung 20: Filter Solarisation



Farben ersetzen

Mit Extras > Farbersetzung öffnet sich der Dialog Farbersetzung (Abbildung 21). 

Abbildung 21: Dialog Farbersetzung

Es können in bis zu vier Zeilen jeweils 

• die Quellfarbe, 

• die Toleranz und 

• für Ersetzen durch eine Farbe oder Transparenz 

gewählt werden. 

Für jede der Farben kann die Quellfarbe mit einer Pipette aus dem zuvor ausgewählten Bild ent-
nommen werden. Dazu wird das Feld für die zu setzende Quellfarbe ausgewählt, sodass es blau 
umrahmt ist, dann wird die Pipette angeklickt und der Mauszeiger über das Bild geführt. Dabei wird 
die Farbe unter der Mausposition bereits in dem Farbfeld neben der Pipette angezeigt. Mit einem 
Klick auf das Bild wird diese Farbe als Quellfarbe übernommen. Soll die Farbe nochmal geändert 
werden, so ist erneut auf die Pipette zu klicken. 

Die Quellfarbe kann nicht aus der Farbpalette gewählt werden. Jedoch kann die Pipette auch auf 
andere Formen angewendet werden, in denen eine Farbe aus der Farbpalette verwendet wurde.

Die Toleranz ist von 0 bis 99% einstellbar. Mit einem kleinen Wert werden nur eher kleine 
Bereiche mit sehr ähnlicher Farbe eingeschlossen, mit einem großen Wert auch meist größere 
Bereiche von nur grober Übereinstimmung. 

Die Farbe für Ersetzen durch kann im Auswahlmenü aus den verfügbaren Farbpaletten (ein-
schließlich zuvor in Benutzerdefiniert festgelegten Farben) ausgewählt werden, oder es kann 
Transparent gewählt werden.

Anstelle der Quellfarben kann die Transparenz durch eine Farbe ersetzt werden, indem das 
Kontrollkästchen Transparenz angewählt wird. Die Einstellungen für die Quellfarben haben dann 
keine Wirkung und werden ausgegraut. Die Farbe, die die Transparenz ersetzen soll, kann im 
Auswahlmenü ebenfalls aus den Farbpaletten ausgewählt werden. 

Mit einem Klick auf Ersetzen wird die Funktion auf das ausgewählte Bild angewendet. Die 
Funktion ist nicht für Teilbereiche eines Bildes oder für mehrere gleichzeitig ausgewählte Bilder 
möglich. Mit Rückgängig kann die Funktion zurückgenommen werden.

Bleibt der Dialog Farbersetzung geöffnet, dann können 

• weitere Bilder mit der gleichen Einstellung der Farbersetzung bearbeitet werden und 

• die Einstellung der Farbersetzung geändert und erneut auf dieses oder andere Bilder 
angewendet werden. 
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Der Dialog wird mit dem  in der Titelleiste oder mit der 

Esc -Taste geschlossen. Damit geht diese Einstellung 
verloren und kann i. d. R. nicht exakt wiederhergestellt 
werden. 

Das im Abschnitt Grafikfilter verwendete Beispielbild wird 
mit der in Abbildung 21 gezeigten Dialogeinstellung zu dem 
Bild in Abbildung 22. Durch die Toleranz ergeben sich mehr 
oder weniger große Flächen mit gleicher ersetzter Farbe, 
ähnlich den Grafikfiltern Pop-Art oder Poster.
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Abbildung 22: Beispiel Farbersetzung



Umwandeln

Unter Form > Umwandeln, im Kontextmenü eines Bildes und in den Symbolleisten Zeichnung und 
Verändern finden sich Befehle zur Umwandlung eines Bildes. 

In Kurve

Mit Form > Umwandeln > In Kurve  wird die Linie des Bildes in eine Bézierkurve 
umgewandelt und das Bild als Füllung verwendet. Mit Bearbeiten > Punkte können danach im 
Modus Punkte bearbeiten die Eckpunkte bearbeitet werden, siehe Draw Handbuch Kapitel 11 - 
Fortgeschrittene Zeichentechniken, Abschnitt Bézierkurven und Polygone.

In Polygon

Mit Form > Umwandeln > In Polygon  – wird das Bild in eine Vielzahl von Polygonen mit 
Farbfüllung umgewandelt. Durch die Zahl der Polygone kann sich ein sehr hoher Ressourcen-
bedarf ergeben, der möglicherweise zu Problemen führt. 

• Die Anzahl der Farben, d. h. wie viele Farben im konvertierten Bild wiedergegeben werden 
sollen, kann von 8 bis 32 gewählt werden. Für jedes Auftreten einer Farbe im Bild generiert 
LibreOffice ein Polygon. 

• Die Punkt-Reduktion kann von 0 bis 32 gewählt werden, diese entfernt Farbpolygone, die 
kleiner sind als der eingegebene Pixelwert. Optional können mit Löcher füllen die Farblücken 
ausgefüllt werden, die durch eine Punktreduktion entstanden sind, dabei kann eine 
Kachelgröße von 8 bis 128 Pixel gewählt werden. 

Abbildung 23 zeigt ein Bild und die durch die Umwandlung entstandenen ca. 11000 Polygone.

Abbildung 23: Bild und Umwandlung in Polygone

Die erzeugten Polygone sind nach der Umwandlung zu einem einzigen Objekt verbunden, siehe 
Draw Handbuch Kapitel 5 - Arbeiten mit mehreren Objekten. 

In Kontur

Mit Form > Umwandeln > In Kontur  wird die Linie des Bildes in ein Polygon umgewandelt 
und das Bild als Füllung verwendet. Mit Bearbeiten > Punkte kann danach im Modus Punkte 
bearbeiten die Form geändert werden, siehe Draw Handbuch Kapitel 11 - Fortgeschrittene 
Zeichentechniken, Abschnitt Bézierkurven und Polygone. 
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In 3D

Mit Form > Umwandeln > In 3D  wird das Bild in ein plastisch 
wirkendes Objekt umgewandelt, das durch einen zweiten Klick auf 
das Bild oder mit Form > Drehen interaktiv im Raum gedreht werden 
kann, siehe Abbildung 24.

In 3D-Rotationskörper

Mit Form > Umwandeln > In 3D-Rotationskörper  wird das Bild in 
einen Rotationskörper umgewandelt, der durch einen zweiten Klick auf 
das Bild oder mit Form > Drehen interaktiv im Raum gedreht werden 
kann, siehe Abbildung 25. 

In Bitmap

Mit Form > Umwandeln > In Bitmap  wird eine Form, z. B. ein gefülltes Rechteck, ein Kreis 
oder ein Textfeld, in ein Bitmap-Bild umgewandelt. Damit wird die Vektorgrafik zu einer Raster-
grafik, zuvor in der Vektorgrafik gewählte Eigenschaften wie Linie, Fläche und Transparenz und 
Text können nicht mehr verändert werden. 

In MetaFile

Mit Form > Umwandeln > In MetaFile kann ein als Bitmap, d. h. in PNG codiertes Bild in ein 
Windows Metafile (WMF, siehe https://de.wikipedia.org/wiki/Windows_Metafile) umgewandelt 
werden. Dieses Format verwendet MS-Windows für die Zwischenablage. 
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Abbildung 24: Bild in 3D

Abbildung 25: Bild in 
3D-Rotationskörper

https://de.wikipedia.org/wiki/Windows_Metafile


Weitere Informationen

Handbücher der LibreOffice Community

Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die 
Kapitelübersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications

LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung

• Calc - Tabellenkalkulation

• Impress - Präsentationen

• Draw - Zeichnungen

• Base - Datenbanken

• Math - Formeleditor

Die Kapitel

Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit eine anderen Office-Suite 
vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen

Alle Kapitel können frei als PDF-Version heruntergeladen werden:

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren

Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice

LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie Windows, 
GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.

LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der Gemeinschaft der 
Stiftung The Document Foundation / https://de.libreoffice.org/about-us/governance/. Die Stiftung 
hat ihren Sitz in Berlin / Deutschland.

Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Draw Handbuch

Kapitel 1 - Einführung in Draw

Kapitel 2 - Zeichnen von Formen

Kapitel 3 - Arbeiten mit Objekten und Objektpunkten

Kapitel 4 - Objekteigenschaften ändern

Kapitel 5 - Arbeiten mit mehreren Objekten

Kapitel 6 - Bilder bearbeiten (Rasterbilder)

Kapitel 7 - Arbeiten mit 3D Objekten

Kapitel 8 - Verbinder, Fluss- und Organisationsdiagramme

Kapitel 9 - Text einfügen und formatieren

Kapitel 10 - Drucken, Exportieren, E-Mailen

Kapitel 11 - Fortgeschrittene Zeichentechniken

Anhang B - Optionen
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Hilfe

So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe

Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.

Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.

Betätigen Sie die Taste F1.

Online-Hilfe

Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.

Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:

LibreOffice online Hilfe

Offline- und Online-Hilfe

Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.

Im linken oberen Bereich bei Index befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe 
eingeben. Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl 
von Themen. Mit jedem weiter Buchstaben konkretisiert sich die Auswahl.

KLICKEN Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren Bereich 
des Fenster zu lesen.

Noch Fragen?

Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:

Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice

Besuchen Sie uns auch auf der Seite Dabei sein!:

LibreOffice Community

Spenden

LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die rein 
freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software gefällt, freuen 
wir uns über eine Spende auf Spenden für die Document Foundation.
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